
Pexip Infinity
Getting Started Guide

Introduction
Pexip Infinity is a virtualized and distributed multipoint conferencing platform. It enables scaling of video, voice and data 
collaboration across organizations, enabling everyone to engage in high definition video, web, and audio conferencing.

It provides any number of users with their own personal Virtual Meeting Rooms, as well as Virtual Auditoriums, which they can use 
to hold conferences, share presentations, and chat. Participants can join over audio or video from any location using virtually any 
type of communications tool (such as Microsoft Lync / Skype for Business, a traditional conferencing endpoint, a mobile telephone, 
or a Pexip Infinity Connect client) for a seamless meeting experience.

Virtual Meeting Rooms and Virtual Auditoriums can also be accessed through a Virtual Reception IVR service, which allows all 
participants to dial a single number to access Pexip Infinity, and then use the DTMF tones on their endpoint  to select the 
conference they want to join. The platform also includes the Pexip Distributed Gateway service, allowing end users to place point-
to-point calls to other endpoints that use different protocols and media formats.

Pexip Infinity is installed as a Management Node and one or more Conferencing Nodes. All are virtual machines (VMs) that are 
deployed onto host hardware using hypervisors. The Management Node is deployed first, and is then used to configure the Pexip 
Infinity platform and deploy Conferencing Nodes.

This guide describes the minimum steps required to deploy a Pexip Infinity Management Node. It covers the following topics:

Full information on configuring and using Pexip Infinity is available:

 l on the Pexip Infinity technical documentation website (from where all documentation can also be downloaded in PDF format)

 l as online help, by clicking the Help link in the top right corner of the Pexip Infinity Administrator interface (available after the 
Management Node has been deployed).

© 2016 Pexip AS Version 11.b   February 2016 Page 1 of 21

http://docs.pexip.com/


Pexip Infinity Getting Started Guide Prerequisites

© 2016 Pexip AS Version 11.b   February 2016 Page 2 of 21

Prerequisites
This section lists the prerequisites for installing the Pexip Infinity version 11 platform.

There are further requirements for deploying the complete platform in your network. For more information, see Pexip Infinity 
installation overview.

Host servers
The following table lists the recommended hardware requirements for the Management Node and Conferencing Node host servers.

 Management Node Conferencing Node

Server manufacturer Any Any

Processor make* Any Intel Xeon E5-2600 series (Haswell architecture) 
or similar Xeon processors from 2012 or later

Processor instruction set Any AVX2‡

Processor architecture 64-bit 64-bit

Processor speed 2.0 GHz 2.3 GHz or faster

No. of physical cores* 2† 10-12 cores per socket

Processor cache no minimum 20 MB or greater
(2.5 MB L3 cache per core)

Total RAM* 4 GB† 1 GB per core

RAM makeup Any All channels must be populated with a DIMM.

Hardware allocation The host server must not be over-committed in terms of either RAM or CPU. In other words, the 
Management Node and Conferencing Nodes each must have dedicated access to their own RAM 
and CPU cores.

Storage space required 100 GB 50 GB per Conferencing Node

GPU No specific hardware cards or GPUs are required.

Network Gigabit Ethernet connectivity from the host server.

Operating System The Pexip Infinity VMs are delivered as VM images (.ova etc) to be run directly on the hypervisor. 
No OS should be installed.

Hypervisor  l VMware ESXi 4.1, 5.x or 6.0

 l Microsoft Hyper-V 2012 or later

 l Xen 4.2 or later

 l KVM (Linux kernel 3.10.0 or later, and QEMU 1.5.0 or later)

* This does not include the processor and RAM requirements of the Hypervisor.

‡ For VMware platforms, ESXi 6 is required to make full use of the AVX2 instruction set. Note that AVX and SSE4.1 are also supported.

† Sufficient for deployments of up to 30 Conferencing Nodes. For larger deployments, you will need to increase the amount of RAM and 
number of cores. For more information about our server design guidelines, consult your Pexip support representative.

For further information, see the Pexip Infinity Server Design Guide.

http://docs.pexip.com/admin/installation_overview.htm
http://docs.pexip.com/admin/installation_overview.htm
http://docs.pexip.com/admin/server_design.htm
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Hypervisors
Pexip Infinity currently offers specific support for VMware ESXi, Microsoft Hyper-V, KVM and Xen hypervisors. Other hypervisors and 
orchestration layers may be used but are not officially supported. If you wish to deploy Pexip Infinity using a non-supported 
hypervisor, we recommend that you contact your authorized Pexip representative for assistance.

For details on installation using a specific hypervisor, refer to the following sections:

 l Getting started with VMware
 l Getting started with Hyper-V
 l Getting started with KVM
 l Getting started with Xen
 l Getting started with other hypervisors

Network requirements
Note that in all Pexip Infinity deployment scenarios:

 l All Pexip nodes must be fully routable to each other (full mesh) in both directions. This means that the Management Node 
must be able to reach every Conferencing Node, and each Conferencing Node must be able to reach every other Conferencing 
Node.

 l Any internal firewalls must be configured to allow UDP port 500 and traffic using IP protocol 50 (ESP) in both directions 
between all Pexip nodes.

 l There cannot be a NAT between any Pexip nodes.
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Getting started with VMware
This section describes how to deploy the Pexip Infinity Management Node on a VMware vSphere hypervisor.

Supported ESXi versions
Version 11 of the Pexip Infinity platform supports VMware vSphere ESXi 4.1, 5.x and 6.0, although we recommend ESXi 5.5 or 6.0. 
You must have a suitable VMware environment already installed. For information on configuring a VMware environment specifically 
for use with Pexip Infinity, see Advanced VMware ESXi administration.

Supported VMware editions
The Pexip Infinity platform will run on the free edition of vSphere Hypervisor. However, this edition has a number of limitations 
(limited support from VMware, no access to vCenter or vMotion, no access to VMware API). In particular, the lack of access to the 
VMware API means that all Conferencing Nodes will have to be deployed manually. For this reason we do not recommend its use 
except in smaller deployments, or test or demo environments.

The minimum edition of VMware that we recommend is the vSphere Standard edition. This does not have the limitations of the 
free edition. If you do not already use VMware in your enterprise, the vSphere Essentials Kit is a simple way to get started and will 
provide you with Standard edition licenses for 3 servers (with 2 CPUs each) plus a vCenter license.

The Enterprise Plus edition includes further additional features relevant to the Pexip Infinity platform that could be of benefit to 
larger deployments. These include Storage DRS and Distributed Switch.

For a comparison of the VMware editions, see http://www.vmware.com/products/datacenter-virtualization/vsphere/compare-
editions.html.

Synchronizing time
All host servers must be synchronized with accurate time before you install the Pexip Infinity Management Node or 
Conferencing Nodes on them.

 l NTP must be enabled on the Management Node before you deploy any Conferencing Nodes.

 l We strongly recommend that you configure at least three distinct NTP servers or NTP server pools on all your host servers and 
the Management Node itself. This will ensure that log entries from all nodes are properly synchronized.

The following instructions describe how to synchronize time on the host server using the vSphere desktop client. You can also use 
the vSphere web client for hosts managed using vCenter; for instructions on this see Configuring VMware for Pexip Infinity.

To synchronize time on the host server using the vSphere desktop client:

 1. Log in to the VM manager (vCenter Server or the ESXi host).

 2. From the left-hand panel, select the host server on which the software image is to be installed.

 3. Select the Configuration tab.

 4. From the Software pane on the left-hand side, select Time Configuration.

 5. On the top right of the page, select Properties. The Time Configuration dialog box appears.

 6. In the NTP Configuration section, select NTP Client Enabled.

 7. Select Options.     

The NTP Daemon (ntpd) Options dialog box appears.

 8. From the left-hand panel, select General. Under Startup Policy, select Start and stop with host.

 9. Select OK.

 10. Select Options again.     

The NTP Daemon (ntpd) Options dialog box appears.

http://docs.pexip.com/admin/vmware_esxi_administration.htm
http://www.vmware.com/products/datacenter-virtualization/vsphere/compare-editions.html
http://www.vmware.com/products/datacenter-virtualization/vsphere/compare-editions.html
http://docs.pexip.com/admin/configuring_vmware.htm
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 11. From the left-hand panel, select NTP Settings. Under NTP Servers, we strongly recommend that you configure at least 3 
distinct NTP servers or NTP server pools to ensure that log entries from all nodes are properly synchronized.

 12. Select Restart NTP service to apply changes, and then select OK.

To verify that NTP has been enabled correctly:

 1. Select the Configuration tab.

 2. From the Software pane on the left-hand side, select Time Configuration.

 3. Ensure that value in the Date & Time field is correct.

Installing the Management Node VM
The following instructions describe how to install the software image using the vSphere desktop client. You can also use the 
vSphere web client for deployments using vCenter Server; for instructions on this see Installing the Management Node (using the 
vSphere web client).

To install a new instance of a Pexip Infinity Management Node using the vSphere desktop client:

 1. Download the Pexip Infinity OVA file (Pexip_Infinity_v11_VMware_pxMgr_<release>.ova) from www.pexip.com/software-
download.

 2. Log in to the VM Manager (vCenter Server or the ESXi host).

 3. Select File > Deploy OVF Template.... 
You will be taken to the Source page.

 4. Browse to the location of the Pexip Infinity OVA file and select Next >.
You will be taken to the OVF Template Details page.

 5. Select Next >.
You will be taken to the End User License Agreement page.

 6. Read the license agreement, and if you agree to the terms select Accept and then Next >.
You will be taken to the Name and Location page.

 7. Enter an appropriate name for the Management Node. This name will be used in the VMware interface to identify this 
Management Node virtual machine (VM).

 8. Select Next >.
You will be taken to the Resource Pool page.

 9. Select the resource pool for the Pexip Infinity Management Node.

 10. Select Next >.
You will be taken to the Disk Format page.

 11. Select Thick Provision Lazy Zeroed.

 12. Select Next >. 
You will be taken to the Network Mapping page.

 13. Select the appropriate mappings and select Next >. 
You will be taken to the Ready to Complete page.

 14. Review the information and select Power on after deployment.

 15. Select Finish.

A window will appear showing the deployment progress. When deployment is complete this will say Completed Successfully. You 
can then Close the window.

Enabling automatic startup
After deploying a new Management Node  from VMware, you must enable automatic startup of that virtual machine (VM). In 
VMware, automatic startup is disabled by default for every new VM. This means that if the host server is powered down for any 
reason, when it restarts the VM will not restart and must be started manually.

You can only enable automatic startup after the Management Node has been deployed.

http://docs.pexip.com/admin/installing_management_node_vmware.htm
http://docs.pexip.com/admin/installing_management_node_vmware.htm
http://www.pexip.com/software-download
http://www.pexip.com/software-download
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To enable automatic startup using the vSphere desktop client:

 1. Log in to the VM manager (vCenter Server or the ESXi host).

 2. From the left-hand panel, select the host server on which the node's VM is installed.

 3. Select the Configuration tab.

 4. From the Software pane on the left-hand side, select Virtual Machine Startup/Shutdown.             

 5. At the top right of the page, select Properties.

 6. Select the relevant VM and use the Move Up button to move it to the Automatic Startup section.

 7. Select OK.

Opening a console window to run the installation wizard
To run the installation wizard, which configures the Management Node, you must open a console window on the Management 
Node VM. To do this:

 1. Using either the vSphere desktop or web client, log in to the Management Node's VM Manager (vCenter Server or, for stand-
alone deployments, the ESXi host).

 2. Power on the new Management Node VM (if it is not already powered on).

 3. Right-click on the new Management Node VM and select Open Console.

You must now run the installation wizard. For step-by-step instructions, see Running the installation wizard.

Disabling EVC in VMware
We strongly recommend that you disable EVC (Enhanced vMotion Compatibility) for any ESXi clusters hosting Conferencing Nodes 
that include a mix of old and new CPUs. If EVC is enabled on such clusters, the Pexip Infinity platform will run more slowly because 
the Conferencing Nodes will assume they are running on older hardware.

For more information, see Enhanced vMotion Compatibility (EVC)  .

To disable EVC:

 1. Log in to vCenter Server using either the vSphere desktop or web client.

 2. Display the cluster in the inventory.

 3. Right-click the cluster and select Edit Settings.

 4. In the left panel, select VMware EVC.
The dialog box displays the current EVC settings.

 5. Select Change EVC Settings.

 6. Select Disable EVC.

http://docs.pexip.com/admin/vmware_esxi_administration.htm#Enhanced
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Getting started with Hyper-V
This section describes how to deploy the Pexip Infinity Management Node on a Microsoft Hyper-V hypervisor.

Supported Hyper-V versions
Version 11 of Pexip Infinity supports Microsoft Hyper-V in the form of Microsoft Hyper-V Server 2012 and later, or Windows Server 
2012 and later. You must have a suitable Hyper-V environment already installed. For information on configuring a Hyper-V 
environment specifically for use with Pexip Infinity, see Configuring Hyper-V for Pexip Infinity.

Synchronizing time
All host servers must be synchronized with accurate time before you install the Pexip Infinity Management Node or 
Conferencing Nodes on them.

 l NTP must be enabled on the Management Node before you deploy any Conferencing Nodes.

 l We strongly recommend that you configure at least three distinct NTP servers or NTP server pools on all your host servers and 
the Management Node itself. This will ensure that log entries from all nodes are properly synchronized.

In Hyper-V, all time synchronization is configured using the Active Domain Controller. You must ensure that all VMs and host servers 
are using the same time. Consult your Hyper-V documentation for information on how to do this in your environment.

Installing the Management Node VM
To deploy a new instance of a Pexip Infinity Management Node using Hyper-V:

 1. Download the Pexip Infinity ZIP file (Pexip_Infinity_v11_HyperV_pxMgr_<release>.zip) from www.pexip.com/software-
download, and extract the files.

 2. Log in to Hyper-V.

 3. Right-click on the host server and select Import Virtual Machine....
This will start the Import Virtual Machine wizard.

 4. On the Locate Folder page, Browse to the folder containing the extracted files and select Next.
You will be taken to the Select Virtual Machine page.

 5. The wizard will automatically detect the folder and file containing the Management Node VM. Confirm that this is correct and 
select Next.
You will be taken to the Choose Import Type page.

 6. Select the type of import most appropriate for your environment (if you are unsure, select Restore the virtual machine). 
Select Next.

 7. Depending on the import type you have chosen, you may be asked for further information. Follow the prompts as required.
When the setup is complete, you will be taken to the Completing Import Wizard page.

 8. Review the summary and select Finish.

When the Management Node VM has been created successfully, it will appear in the list of Virtual Machines.

Enabling automatic startup
By default, virtual machines deployed using Hyper-V are configured to restart automatically if they were running when the host 
server was shut down or powered off. We recommend that you leave this setting as is for the Management Node and all 
Conferencing Nodes.

http://docs.pexip.com/admin/configuring_hyper-v.htm
http://www.pexip.com/software-download
http://www.pexip.com/software-download
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Opening a console window to run the installation wizard
To run the installation wizard, which configures the Management Node, you must open a console window on the Management 
Node VM. To do this:

 1. Log in to Hyper-V.

 2. Start the new Management Node VM (if it is not already running).

 3. Right-click on the new Management Node VM and select Connect....

You must now run the installation wizard. For step-by-step instructions, see Running the installation wizard.
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Getting started with KVM
This section describes how to deploy the Pexip Infinity Management Node on a KVM hypervisor.

Prerequisites
This guide assumes that you have a KVM environment already installed. 

Pexip Infinity requires your KVM environment to include Linux kernel 3.10.0 or later, and QEMU 1.5.0 or later. This means the 
following distributions: Debian 8, RHEL 7, SLES 12, or Ubuntu 14.04 (or later, where appropriate).

You must ensure that:

 l the KVM environment may be managed through libvirt
 l the virt-manager, virsh and virt-install applications are available for use on the client system that is managing the KVM 

environment; to do this, run the command:
sudo apt-get install virt-manager libvirt-bin

The libvirt command line tools are used to import the disk image and create the VM. Note that we use the libvirt command line 
tools to perform the import as they provide greater control than Virtual Machine Manager. For more information, see 
http://libvirt.org/drvqemu.html.

Synchronizing time
All host servers must be synchronized with accurate time before you install the Pexip Infinity Management Node or 
Conferencing Nodes on them.

 l NTP must be enabled on the Management Node before you deploy any Conferencing Nodes.

 l We strongly recommend that you configure at least three distinct NTP servers or NTP server pools on all your host servers and 
the Management Node itself. This will ensure that log entries from all nodes are properly synchronized.

Install the NTP package on your host server using the appropriate package management tool for your Linux distribution.

Installing the Management Node VM
To deploy a new instance of a Pexip Infinity Management Node on to a KVM host, you must:

 1. Download the Management Node OVA image file and convert it for use with KVM.

 2. Create a new volume on your KVM server and upload the disk image.

 3. Create the Management Node virtual machine.
Note that we use the libvirt command line tools to perform the import as they provide greater control than Virtual Machine 
Manager.

 4. Enable the virtual machine for automatic startup.

These steps are described in detail below.

Download the Pexip .ova image and convert it for use with KVM
You must download the Management Node OVA image file and then, to use it with KVM, you must convert it from VMDK to raw 
format.

From within your KVM environment:

 1. Download the Pexip Infinity OVA file (Pexip_Infinity_v11_VMware_pxMgr_<release>.ova) from www.pexip.com/software-
download.
(The VMware OVA file is used for KVM deployments.)

http://libvirt.org/drvqemu.html
http://www.pexip.com/software-download
http://www.pexip.com/software-download
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 2. Unpack the .ova image, using the command:
tar xf Pexip_Infinity_v11_VMware_pxMgr_<release>.ova

This unpacks a set of files including pexipmcumgr-disk01.vmdk.

 3. If required, you can verify the pexipmcumgr.mf manifest file, using the command:
sha1sum -c pexipmcumgr.mf

 4. Convert the disk image from VMDK to raw, using the command:
qemu-img convert -O raw pexipmcumgr-disk01.vmdk pexipmcumgr-disk01.raw

(This conversion process can take several seconds.)

Create a new volume and upload the disk image
Next, you create a new volume on your KVM server and upload the converted disk image. From within your KVM environment:

 1. Use virsh to create a new volume on your KVM server:
virsh --connect qemu://<hostname>/system vol-create-as <poolname> <volume_name> 99G --format raw

where:
<hostname> is the hostname of your KVM server. Note that you can omit the <hostname> if you are running virsh commands on 
the local server i.e. you can use virsh --connect qemu:///system  .
<poolname> is the name of the storage pool in which to create the volume; typically you would use default. (To determine the 
storage pools available on the target system, use virsh --connect qemu://<hostname>/system pool-list.)
<volume_name> is the name of your new volume.
99G is the virtual size of the volume; always use 99G for a Management Node.
For example:
virsh --connect qemu://host1.example.com/system vol-create-as default pexip-manager 99G --format raw

This example creates a volume named pexip-manager of size 99 GB and format raw in the storage pool named default.

 2. Upload the converted disk image to the newly created volume:
virsh --connect qemu://<hostname>/system vol-upload <volume_name> pexipmcumgr-disk01.raw --pool <poolname>

For example:
virsh --connect qemu://host1.example.com/system vol-upload pexip-manager pexipmcumgr-disk01.raw --pool default

This example uploads the pexipmcumgr-disk01.raw image to the newly created volume, pexip-manager, in the storage pool 
named default.

Create the virtual machine
After the disk image has been uploaded, you can create the virtual machine to use it.

Note that we use the libvirt command line tools to perform the import as they provide greater control than Virtual Machine 
Manager.

 1. Identify the filesystem path of the newly uploaded disk image:
virsh --connect qemu://<hostname>/system vol-path <volume_name> --pool <poolname>

For example:
virsh --connect qemu://host1.example.com/system vol-path pexip-manager --pool default

This prints out the absolute path to the disk image file, for example:
/var/lib/libvirt/images/pexip-manager

This path is used in the disk path parameter in the next step.

 2. Use the virt-install command line tool to create the virtual machine:
 virt-install \
   --import \
   --hvm \
   --name=<vm_name> \
   --arch=x86_64 \
   --vcpus=2 \
   --ram=4096 \
   --cpu host \
   --os-type=linux \
   --connect=qemu://<hostname>/system \
   --virt-type kvm \
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   --disk path=<image_file_path>,bus=virtio,format=raw,cache=none,io=native \
   --network bridge=br0,model=virtio \
   --memballoon virtio \
   --graphics vnc,listen=0.0.0.0,password=<password>

This creates a new VM (KVM domain) from the converted disk image.
The meaning of the various options are as follows (items in bold may be changed as necessary):

Option Description

--import Build guest domain around pre-installed disk image; do not attempt to install a new OS.

--hvm Create a fully virtualized (i.e. not paravirtualized) VM.

--name=<vm_name> Name of the new VM, where <vm_name> is, for example, pexip-management-vm.

--arch=x86_64 CPU architecture of new VM (must be x84_64).

--vcpus=2 Number of CPUs allocated to new VM. Typically, this is 2 for the Management Node.

--ram=4096 Memory allocated to new VM (in megabytes).

--cpu host Expose all host CPU capabilities to new VM (CPUID).

--os-type=linux The guest OS is Linux.

--
connect=
qemu://<hostname>/system

Connect to KVM on the target system, where <hostname> is the hostname of your KVM server.

--virt-type kvm Use KVM to host the new VM.

--disk path=<image_file_path>,
bus=virtio
,format=raw,cache=none,io=native

 o Define the location of the disk image file, where <image_file_path> is as determined in the 
previous step, for example /var/lib/libvirt/images/pexip-manager.

 o Expose it to the guest on the virtio paravirtualized bus (as opposed to IDE/SCSI).

 o Define the image file as being in raw format.

 o Instruct the host system not to cache the disk contents in memory.

 o Use the native IO backend to access the disk device.

--network 
bridge=br0,model=virtio

 o Create a network interface connected to the br0 bridge interface on the host.

 o Expose it to the guest as a virtio paravirtualized NIC.

--memballoon virtio Expose the virtio memory balloon to the guest.

--graphics vnc,listen=0.0.0.0,
password=<password>

Expose the graphical console over VNC, listening on 0.0.0.0 (i.e. all addresses on the target system) 
and with an access password of <password>.

You may receive a warning "Unable to connect to graphical console: virt-viewer not installed"; if so, this message can be safely 
ignored.
After the VM has been created, it may be managed using the Virtual Machine Manager desktop interface (virt-manager 
application) or via the command line interface (virsh).
The new node should start automatically. If it does not you can use the Virtual Machine Manager to start the node, or the CLI 
command:
virsh --connect qemu://<hostname>/system start <vm_name>

Note that you can list existing VMs by using virsh --connect qemu://<hostname>/system list

Enabling automatic startup
After deploying a new Management Node in KVM, you should enable automatic startup of that virtual machine (VM). In KVM, 
automatic startup is disabled by default for every new VM. This means that if the host server is powered down for any reason, when 
it restarts the VM will not restart and must be started manually.

You can only enable automatic startup after the Management Node has been deployed.
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To enable automatic startup using Virtual Machine Manager:

 1. Connect to the Virtual Machine Manager (virt-manager) that is managing the node's VM.

 2. Select the node's VM and then, from the toolbar, select the Show the virtual machine console and details icon .
A new window for that VM is opened.

 3. If necessary, select View > Details to display the VM information.

 4. From the sidebar menu, select Boot Options.

 5. Select the Start virtual machine on host boot up check box.

 6. Select Apply.

Opening a console window to run the installation wizard
To run the installation wizard, which configures the Management Node, you must open a console window on the Management 
Node VM. To do this:

 1. Connect to Virtual Machine Manager (virt-manager) that is managing the Management Node's VM.

 2. Ensure that the Management Node VM is Running.

 3. Select the new Management Node VM and then, from the toolbar, select the Show the virtual machine console and details 

icon .
A new window for that VM is opened.

 4. If necessary, select View > Console to display the console.

You must now run the installation wizard. For step-by-step instructions, see Running the installation wizard.



Pexip Infinity Getting Started Guide Getting started with Xen

© 2016 Pexip AS Version 11.b   February 2016 Page 13 of 21

Getting started with Xen
This section describes how to deploy the Pexip Infinity Management Node on a Xen hypervisor.

Prerequisites
This guide assumes that you have a Xen environment already installed. Pexip Infinity requires Xen 4.2 and later.

You must ensure that:

 l the Xen environment may be managed through libvirt
 l the virt-manager, virsh and virt-install applications are available for use on the client system that is managing the Xen 

environment; to do this, run the command:
sudo apt-get install virt-manager libvirt-bin

The libvirt command line tools are used to import the disk image and create the VM. Note that we use the libvirt command line 
tools to perform the import as they provide greater control than Virtual Machine Manager. For more information, see 
http://libvirt.org/drvxen.html.

Synchronizing time
All host servers must be synchronized with accurate time before you install the Pexip Infinity Management Node or 
Conferencing Nodes on them.

 l NTP must be enabled on the Management Node before you deploy any Conferencing Nodes.

 l We strongly recommend that you configure at least three distinct NTP servers or NTP server pools on all your host servers and 
the Management Node itself. This will ensure that log entries from all nodes are properly synchronized.

Install the NTP package on your host server using the appropriate package management tool for your Linux distribution.

Installing the Management Node VM
To deploy a new instance of a Pexip Infinity Management Node on to a Xen host, you must:

 1. Download the Management Node OVA image file and convert it for use with Xen.

 2. Create a new volume on your Xen server and upload the disk image.

 3. Create the Management Node virtual machine.
Note that we use the libvirt command line tools to perform the import as they provide greater control than Virtual Machine 
Manager.

 4. Enable the virtual machine for automatic startup.

These steps are described in detail below.

Download the Pexip .ova image and convert it for use with Xen
You must download the Management Node OVA image file and then, to use it with Xen, you must convert it from VMDK to raw 
format.

From within your Xen environment:

 1. Download the Pexip Infinity OVA file (Pexip_Infinity_v11_VMware_pxMgr_<release>.ova) from www.pexip.com/software-
download.
(The VMware OVA file is used for Xen deployments.)

 2. Unpack the .ova image, using the command:
tar xf Pexip_Infinity_v11_VMware_pxMgr_<release>.ova

This unpacks a set of files including pexipmcumgr-disk01.vmdk.

http://libvirt.org/drvxen.html
http://www.pexip.com/software-download
http://www.pexip.com/software-download


Pexip Infinity Getting Started Guide Getting started with Xen

© 2016 Pexip AS Version 11.b   February 2016 Page 14 of 21

 3. If required, you can verify the pexipmcumgr.mf manifest file, using the command:
sha1sum -c pexipmcumgr.mf

 4. Convert the disk image from VMDK to raw, using the command:
qemu-img convert -O raw pexipmcumgr-disk01.vmdk pexipmcumgr-disk01.raw

(This conversion process can take several seconds.)

Create a new volume and upload the disk image
Next, you create a new volume on your Xen server and upload the converted disk image. From within your Xen environment:

 1. Use virsh to create a new volume on your Xen server:
virsh --connect xen://<hostname>/ vol-create-as <poolname> <volume_name> 99G --format raw

where:
<hostname> is the hostname of your Xen server. Note that you can omit the <hostname> if you are running virsh commands on 
the local server i.e. you can use virsh --connect xen:///  .
<poolname> is the name of the storage pool in which to create the volume; typically you would use default. (To determine the 
storage pools available on the target system, use virsh --connect xen://<hostname>/ pool-list.)
<volume_name> is the name of your new volume.
99G is the virtual size of the volume; always use 99G for a Management Node.
For example:
virsh --connect xen://host1.example.com/ vol-create-as default pexip-manager 99G --format raw

This example creates a volume named pexip-manager of size 99 GB and format raw in the storage pool named default.

 2. Upload the converted disk image to the newly created volume:
virsh --connect xen://<hostname>/ vol-upload <volume_name> pexipmcumgr-disk01.raw --pool <poolname>

For example:
virsh --connect xen://host1.example.com/ vol-upload pexip-manager pexipmcumgr-disk01.raw --pool default

This example uploads the pexipmcumgr-disk01.raw image to the newly created volume, pexip-manager, in the storage pool 
named default.

Create the virtual machine
After the disk image has been uploaded, you can create the virtual machine to use it.

Note that we use the libvirt command line tools to perform the import as they provide greater control than Virtual Machine 
Manager.

 1. Identify the filesystem path of the newly uploaded disk image:
virsh --connect xen://<hostname>/ vol-path <volume_name> --pool <poolname>

For example:
virsh --connect xen://host1.example.com/ vol-path pexip-manager --pool default

This prints out the absolute path to the disk image file, for example:
/var/lib/libvirt/images/pexip-manager

This path is used in the disk path parameter in the next step.

 2. Use the virt-install command line tool to create the virtual machine:
 virt-install \
   --import \
   --hvm \
   --name=<vm_name> \
   --arch=x86_64 \
   --vcpus=2 \
   --ram=4096 \
   --os-type=linux \
   --connect=xen://<hostname>/ \
   --virt-type xen \
   --disk path=<image_file_path>,bus=xen,format=raw,driver_name=qemu,cache=none,io=native \
   --network bridge=xenbr0,model=e1000 \
   --memballoon xen \
   --graphics vnc,listen=0.0.0.0,password=<password>

This creates a new VM (Xen domain) from the converted disk image.
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The meaning of the various options are as follows (items in bold may be changed as necessary):

Option Description

--import Build guest domain around pre-installed disk image; do not attempt to install a new OS.

--hvm Create a fully virtualized (i.e. not paravirtualized) VM.

--name=<vm_name> Name of the new VM, where <vm_name> is, for example, pexip-management-vm.

--arch=x86_64 CPU architecture of new VM (must be x84_64).

--vcpus=2 Number of CPUs allocated to new VM. Typically, this is 2 for the Management Node.

--ram=4096 Memory allocated to new VM (in megabytes).

--os-type=linux The guest OS is Linux.

--
connect=
xen://<hostname>/

Connect to Xen on the target system, where <hostname> is the hostname of your Xen server.

--virt-type xen Use Xen to host the new VM.

--disk path=<image_file_
path>,
bus=xen,format=raw,
driver_
name=qemu
,cache=none,io=native

 o Define the location of the disk image file, where <image_file_path> is as determined in the previous 
step, for example /var/lib/libvirt/images/pexip-manager.

 o Expose it to the guest on the xen paravirtualized bus (as opposed to IDE/SCSI).

 o Define the image file as being in raw format and the driver as qemu.

 o Instruct the host system not to cache the disk contents in memory.

 o Use the native IO backend to access the disk device.

--network 
bridge=
xenbr0,model=e1000

 o Create a network interface connected to the xenbr0 bridge interface on the host.

 o Expose it to the guest as an e1000 NIC.

--memballoon xen Expose the xen memory balloon to the guest.

--graphics 
vnc,listen=0.0.0.0,
password=<password>

Expose the graphical console over VNC, listening on 0.0.0.0 (i.e. all addresses on the target system) and 
with an access password of <password>.

You may receive a warning "Unable to connect to graphical console: virt-viewer not installed"; if so, this message can be safely 
ignored.
After the VM has been created, it may be managed using the Virtual Machine Manager desktop interface (virt-manager 
application) or via the command line interface (virsh).
The new node should start automatically. If it does not you can use the Virtual Machine Manager to start the node, or the CLI 
command:
virsh --connect xen://<hostname>/ start <vm_name>

Note that you can list existing VMs by using virsh --connect xen://<hostname>/ list

Enabling automatic startup
After deploying a new Management Node in Xen, you should enable automatic startup of that virtual machine (VM). In Xen, 
automatic startup is disabled by default for every new VM. This means that if the host server is powered down for any reason, when 
it restarts the VM will not restart and must be started manually.

You can only enable automatic startup after the Management Node has been deployed.

To enable automatic startup using Virtual Machine Manager:

 1. Connect to the Virtual Machine Manager (virt-manager) that is managing the node's VM.

 2. Select the node's VM and then, from the toolbar, select the Show the virtual machine console and details icon .
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A new window for that VM is opened.

 3. If necessary, select View > Details to display the VM information.

 4. From the sidebar menu, select Boot Options.

 5. Select the Start virtual machine on host boot up check box.

 6. Select Apply.

Opening a console window to run the installation wizard
To run the installation wizard, which configures the Management Node, you must open a console window on the Management 
Node VM. To do this:

 1. Connect to Virtual Machine Manager (virt-manager) that is managing the Management Node's VM.

 2. Ensure that the Management Node VM is Running.

 3. Select the new Management Node VM and then, from the toolbar, select the Show the virtual machine console and details 

icon .
A new window for that VM is opened.

 4. If necessary, select View > Console to display the console.

You must now run the installation wizard. For step-by-step instructions, see Running the installation wizard.
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Getting started with other hypervisors
Pexip Infinity currently offers specific support for VMware ESXi, Microsoft Hyper-V, KVM and Xen hypervisors. Other hypervisors and 
orchestration layers may be used but are not officially supported. If you wish to deploy Pexip Infinity using a non-supported 
hypervisor, we recommend that you contact your authorized Pexip representative for assistance.

Some basic guidance is given below. Refer to your hypervisor's documentation for complete instructions on how to perform these 
tasks.

Static IP addressing
Pexip Infinity Management Nodes and Conferencing Nodes support static IP addressing only. Therefore the hypervisor or 
orchestration layer must also support static IP addressing.

Synchronizing time
All host servers must be synchronized with accurate time before you install the Pexip Infinity Management Node or 
Conferencing Nodes on them.

 l NTP must be enabled on the Management Node before you deploy any Conferencing Nodes.

 l We strongly recommend that you configure at least three distinct NTP servers or NTP server pools on all your host servers and 
the Management Node itself. This will ensure that log entries from all nodes are properly synchronized.

Installing the Management Node VM
To install a new instance of a Management Node VM:

 1. Download the Pexip Infinity OVA file (Pexip_Infinity_v11_VMware_pxMgr_<release>.ova) from www.pexip.com/software-
download.

 2. Use this file to create an instance of a Management Node VM.

Opening a console window to run the installation wizard
To run the installation wizard, which configures the Management Node, you must open a console window on the Management 
Node VM. 

You must then run the installation wizard. For step-by-step instructions, see Running the installation wizard.

http://www.pexip.com/software-download
http://www.pexip.com/software-download
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Running the installation wizard
When you have opened a console window on the Management Node VM, the following prompt will appear:
pexipmcumgr login:

To run the installation wizard:

 1. At the prompt, enter the username admin.
The display will read:
You are required to change your password immediately (root enforced)
Enter new UNIX password:

 2. Create a password for the Management Node operating system by typing the password, pressing enter, retyping the password, 
and pressing enter again.

 3. Ensure you record the password in a secure location. After you have finished running the installation wizard you will not need 
the password again unless you need to access the Management Node using SSH.
You will be presented with another login prompt:
Running Pexip installation wizard...
[sudo] password for admin:

 4. Log in again with the password you just created.
The Pexip installation wizard will begin.

 5. Follow the prompts to set the following configuration for the Management Node. 
If you press enter, the default value will be applied:

Setting Default value Multiple entries allowed? Can be changed via Pexip Infinity 
Administrator interface?

IP address 192.168.0.100 * No No ‡

Network mask 255.255.255.0 * No No ‡

Gateway 192.168.0.1 * No No ‡

Hostname <no default> No No ‡

Domain suffix <no default> No No ‡

DNS server 8.8.8.8 Yes, if separated by a space Yes

NTP server † Two of the following:

 o 0.pexip.pool.ntp.org

 o 1.pexip.pool.ntp.org

 o 2.pexip.pool.ntp.org

 o 3.pexip.pool.ntp.org

Yes, if separated by a space Yes

Web administration username admin No No ‡

Web administration password <no default> No Yes

Enable incident reporting 
(yes/no)

<no default>  Yes

Send deployment and usage 
statistics to Pexip (yes/no)

<no default>  Yes

* These defaults apply only if your network does not have DHCP enabled. If DHCP is enabled, the defaults will be those allocated by the 
DHCP server. The addresses you enter using this wizard will be assigned as static IP addresses.

† The NTP server must be accessible by the Management Node at the time the startup wizard is run. Installation will fail if the 
Management Node is unable to synchronize its time with an NTP server.

‡ After they have been configured, do not attempt to change these settings by any other means. To change these settings, you must re-
run the installation wizard.
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The installation will begin and the Management Node will restart using the values you have configured.
When the Management Node has restarted the console will display a login prompt:
<hostname> login:
At this point you can close the console. All further configuration should now be done using the Administrator interface (if you 
encounter SSL connection errors when using the Administrator interface, wait a few seconds to allow the relevant services to 
start before trying again).

Next steps
After you have run the installation wizard, all further configuration should be done using the Pexip Infinity Administrator interface. 
See Next steps.
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Next steps
After you have run the installation wizard, all further configuration should be done using the Pexip Infinity Administrator interface.

Accessing the Pexip Infinity Administrator interface
The Pexip Infinity Administrator interface is hosted on the Management Node. To access this:

 1. Open a web browser and type in the IP address or DNS name that you assigned to the Management Node using the installation 
wizard (you may need to wait a minute or so after installation is complete before you can access the Administrator interface).

 2. Until you have uploaded appropriate TLS certificates to the Management Node, your browser may present you with a warning 
that the website's security certificate is not trusted. You should proceed, but upload appropriate TLS certificates to the 
Management Node (and Conferencing Nodes, when they have been created) as soon as possible.
The Pexip Infinity Conferencing Platform login page will appear.

 3. Log in using the web administration username and password you set using the installation wizard.

You are now ready to begin configuring the Pexip Infinity service and deploying Conferencing Nodes.

Before you can begin to use the Pexip Infinity service, you must:

 l configure the Pexip Infinity platform
 l integrate the Pexip Infinity platform with your call control system

Brief details of how to perform these steps are given below. For complete information on how to configure your Pexip Infinity 
solution, see the Pexip Infinity technical documentation website at docs.pexip.com.

Configuring the Pexip Infinity platform
From the Pexip Infinity Administrator interface, you must:

Task Notes

Add details of a VM manager (applies to VMware environments 
only)
(System configuration > VM Managers)

This is the address of the application to use when automatically 
deploying your Conferencing Nodes. It is your vCenter Server, or if 
you are not using vCenter, it is vSphere on the ESXi host.

Add licenses
(Platform configuration > Licenses)

You must install a system license and sufficient concurrent port 
licenses before you can place calls to Pexip Infinity Virtual Meeting 
Rooms.

Add a system location
(Platform configuration > Locations)

These are labels that allow you to group together Conferencing 
Nodes that are in the same datacenter.

Deploy Conferencing Nodes
(Platform configuration > Conferencing Nodes)

These handle the call signaling and media and get their Virtual 
Meeting Room settings from the Management Node.

Upload TLS certificates
(Platform configuration > TLS certificates)

You must install TLS certificates on the Management Node and each 
Conferencing Node. TLS certificates are used by these systems to 
verify their identity to clients connecting to them.

Add Virtual Meeting Rooms and/or Virtual Auditoriums
(Service configuration > Virtual Meeting Rooms)
(Service configuration > Virtual Auditoriums)

Conferences take place in Virtual Meeting Rooms and Virtual 
Auditoriums. Configuration includes any PINs required to access the 
conference.

Add one or more aliases for each Virtual Meeting Room and 
Virtual Auditorium
(done while adding the Virtual Meeting Room or Virtual Auditorium)

A Virtual Meeting Room or Virtual Auditorium can have more than 
one alias. Conference participants can access a Virtual Meeting Room 
or Virtual Auditorium by dialing any one of its aliases directly.

http://docs.pexip.com/
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Integrating with a call control system
To integrate Pexip Infinity with your call control system, you must configure a trunk or neighbor zone towards each of the 
Conferencing Nodes.

For further information about how to configure your specific call management system to work with Pexip Infinity, see the following 
documentation:

 l Pexip Infinity and Microsoft Lync / Skype for Business Deployment Guide
 l Pexip Infinity and Cisco VCS Deployment Guide
 l Pexip Infinity and Cisco Unified Communications Manager Deployment Guide
 l Pexip Infinity and Polycom DMA Deployment Guide

http://docs.pexip.com/lync/introduction.htm
http://docs.pexip.com/vcs/introduction.htm
http://docs.pexip.com/cucm/cucm_introduction.htm
http://docs.pexip.com/dma/dma_introduction.htm
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